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GIMP Paint Shop (GPS) Tools Description

Paintbrush Presets

Graphite Pencil

2B Pencil

6B Pencil

Graphite Shadow

BIC Pen

Nice Sketching Pen

Normal Brush

Detail Brush

Fast Block Brush

Palette Knife

Block-Brush

Block-Brush Small

Oils-1 Small

Oils-1 Big

Soft Oils Small

Soft-Oils Big

Dust

Normal Dust

Rough Dust

Cond Dust

Scratches

Rocks & Mountains

Line Texture

Leafs1

Foliage1

Noise Scratch

Dirty Spot

Clouds

Clouds Details

CoroBalls

Tecno

Circle Chain

Glares(FX)

Glow Lights (FX)

Glow Darks (FX)

Beam Light

Mith Disc

Total: 38 Presets

Airbrush Presets

Real AirBrush

Digital AirBrush

Block AirBrush

Glow AirBrush (FX)

Total: 4 Presets

Eraser Presets

Soft Eraser

Hard Eraser

Round Eraser

Block Eraser

Total: 4 Presets

Ink Tool Presets

Doodles

Fine Sketch

Medium Sketch

Ink

Total: 5 Presets

Smudge Presets

Note: these tools just blend the  
colors of the active layer

Normal Smudge

Soft Smudge

Artistic Smudge

Jittered Smudge

Balls Smudge

Small-Balls Smudge

Wet Smudge

Total: 7 Presets



What exactly is GPS?
GPS is a collection of brushes and accompanying tool presets intended to speed up repetitive tasks by 
avoiding the need to manually reset tool options after each change.  Tool presets are a simply saved tool 
options, a seldom discussed but highly useful feature of the GIMP.  The goal of GPS is to provide an 
adequate working environment for graphic designers and artists to begin to paint and feel comfortable 
with GIMP from their first use. Later the user will change these settings based on their own workflow 
preferences and understanding of GIMP.

GIMP comes with a default set of brushes that, while limited in scope, are very representative of  the 
available brush types:  ordinary, color, image pipes and parametric.  GIMP's online Help documents 
provide detailed descriptions of all brush types.  Unfortunately, the default set of brushes is hardly 
sufficient for advanced users needs.  Additionally, concept artists and CG illustrators will tell you that 
good brushes alone do not make the artist but only facilitate and accelerate the creation of images.

Ramon Miranda (en) created this set of tool presets and brushes for the illustrator who knows how to 
paint but is not familiar enough with GIMP to make proper use of its tools.  The combined brushes and 
presets can be used for many different tasks, including painting, erasing the blur of airbrushing, and 
inking.

GPS is only a starting point for presets and brushes and is intended to highlight the expansive 
flexibility of GIMP.  It is also intended as a way to learn from  and share with each other within the 
GIMP community.  That is why GPS comes with the Creative Commons license.  As Ramon stated in 
his original release:

I love to see how other users give another twist to this simple concept.

GIMP is not Photoshop
Before starting, every user should keep this one important concept in mind: GIMP is not Photoshop.  If 
you are looking for a free version of Photoshop, GIMP is not it.  GIMP is GIMP and Photoshop is 
Photoshop.  Both have good and bad features like any other software.  Of course they share a common 
set of features including standard digital imaging concepts such as layers, channels, selections, color 
adjustments, and filters.

Both are power tools for digital painting and retouching photographs.  GIMP extends this with a 
powerful infrastructure for batch processing.

But if you're going to learn from and share with a community why not do it with an open community. 
GIMP is open source and Photoshop is not.  Making GIMP less intimidating may help others get 
involved with the community.  GPS is a step in that direction.

http://docs.gimp.org/en/gimp-concepts-brushes.html
http://74.125.77.132/translate_c?hl=en&sl=es&tl=en&u=http://ramonmirandavisualart.blogspot.com/2009/02/gps-v10.html&prev=hp&usg=ALkJrhhRXLPzAcwDDzr6vDmtiCYbnlJlLQ
http://ramonmirandavisualart.blogspot.com/2009/02/gps-v10.html


Prerequisites
In order for GPS to work properly your display should be at least 1280 x 960 
pixels though higher resolution will provide more working space. It is not 
uncommon to work at 1600 x 1200 pixels and higher, or even with 2 
monitors.  Remember that GPS is intended for graphic designers and artists 
who typically have access to larger displays.

How to install GPS
GIMP must be installed on your computer before installing GPS. If it is not 
you can download it from the official website.

Once installed we can continue with the process. If GIMP is already running, 
exit the program (File->Quit).  This will make it easier to follow the 
installation steps. This should only take a few minutes.

• Download the GPS 1.01release.  This is in RAR format.  If you don't 
have a tool to unpack this you can grab a tar.gz  2   or 7zip  3   version 
instead.

• Unpack the file to any folder.  If you open this folder you will find the 
following folders and files:

brushes (folder)

palettes (folder)

sessionrc 

tool-options (folder)

toolrc 

• The brushes folder holds all the GPS brushes. Copy the contents of 
this folder to your GIMP brushes folder

One Linux:

~/.Gimp-2.6/brushes

On Windows:

c:\documents and settings\<your username>\.Gimp-2.6/brushes

• The palettes folder holds all the GPS color palettes.  Copy this file to 
your GIMP palettes folder:

On Linux:

~/.Gimp-2.6/palettes

1 RAR version: http://www.megaupload.com/?d=WRWOBL6S
2 GZIP Tar version: http://www.graphics-muse.org/source/gps_v1.0.tar.gz
3 7zip version:  http://www.jesusda.com/blogpics/gps/gps_v1.0.7z

Toolbox and docks  
using GPS sessionrc

http://www.jesusda.com/blogpics/gps/gps_v1.0.7z
http://www.jesusda.com/blogpics/gps/gps_v1.0.7z
http://www.graphics-muse.org/source/gps_v1.0.tar.gz
http://www.graphics-muse.org/source/gps_v1.0.tar.gz
http://74.125.77.132/translate_c?hl=en&sl=es&tl=en&u=http://www.megaupload.com/?d=WRWOBL6S&prev=hp&usg=ALkJrhhqIUh-MnRpCaiDx4km7gj0ghOK1w
http://www.gimp.org/downloads/


On Windows:

c:\documents and settings\<your username>\.Gimp-2.6/palettes

• Open the tool-options GPS in the folder and copy all its contents inside the folder "tool-options" 
to

~/.Gimp-2.6/tool-options

• If you want to add some tools to the Toolbox then copy the  toolrc file to the top level of your 
GIMP configuration folder.  This file will add icons for the Hue/Saturation and Curves dialogs 
to the Toolbox.

• If you want to use GPS dialog layout then copy the file sessionrc to the top level of your GIMP 
configuration folder.  

Note:  this will change the layout of GIMP's windows.  Save a backup copy of the original  
sessionrc (just rename it to sessionrc.old, for example) that you can restore if the new layout 
does not suit your needs.

• Start Gimp.  The next two steps are optional but will improve the overall usability of the user 
interface.  First,  go to Edit->Preferences->Toolbox and activate the three options there. Then go 
to Edit->Preferences->Tool Options.  On this page, under the Paint Options Shared Between 
Tools, disable the three options (Brush, 
Pattern, and Gradient).

How to manage presets?
Once you have installed the presets and brushes it 
is easy to select the preset you need.  The Tool 
Options dialog will be located in the middle dock 
under the Toolbox. There are 4 icons at the bottom 
that are used to use and manage presets.

• The first icon is used to save the current tool 
options to named presets.  Each tool has it's own 
set of saved options, which means that each tool 
can have more than one set of named presets.

• The second icon is used to load a named preset 
and the one of most interest in exploring the 
features of GPS.  Here you will find the ready-
made configurations that utilize the GPS brushes 
the way they were intended to be used.

• The third icon is used to remove all the named 
presets for the current tool.  Care should be taken 
with this button because once deleted the presets 
cannot be restored (unless you reinstall the GPS 
package).  Also, this button will not ask you for 
confirmation before it deletes the presets.

• The fourth icon is used to restore the current tool 



to its default configuration.  This does not affect the named presets.

Select the appropriate tool from the Toolbox, then click the Restore icon at the bottom of the Tool 
Options dialog.  This will display the list of available presets.  Choose the preset you wish to work with 
and begin using the tool in the image window.

Using the GPS Palettes

GPS includes a set of 15 color palettes that are not directly associated 
with the use of the tool presets.  Instead, these palettes are a collection of 
common colors artists might find useful with various projects.  This 
includes color collections such as human lips, fabric jeans and natural 
wood.  

The sessionrc file will configure multiple FG/BG Color tabs to be 
opened in the bottom dock of the Toolbox.  The first of these allows 
selecting colors for the foreground and background using a common 
color wheel.  The second allows selecting colors from a color palette. 
The third tab is used to select the GPS palettes which can then be utilized 
using the second tab.  

Modifications to palettes (which should be saved under new color palette 
names) can be made in the fourth tab of the same dock.



Paintbrush Presets
These presets are listed by the name found in the Tool Options Restore icon's menu.

Graphite Pencil

Semi-hard edge but with a fairly accurate outline for details. Be 
between a 2b and a pencil in quality of stroke. If we are 
experienced designers, this tool is sufficient to develop the pre-
fit. It has the advantages of a pencil but not so hard. (Although 
raising and lowering the opacity a little size can be a hard pencil 
easily).

2B Pencil

It's like a real pencil 2b. Have a tip is not very hard, which is 
perfect for quick lace where there is not much detail and only a 
rough idea of looking for shapes and volumes. Is thought not to 
reach a pitch black, but gray.

6B Pencil

Soft tip is ideal for shade but no details to draw (you can not make 
nice with the tabs). But as in real life, can increase the range of 
shade or make it more intense by drawing some key points of tap 
much contrast. It may seem a little greasy, or at least it seems to 
me when I use it but it is fun making more mess drawings XDD 
loose.

Graphite Shadow

Something that is often very useful in traditional painting is to 
apply shading to our quick sketches for catching the feeling of 
being a 3D object and we can work better lighting for our image. 
This tool was created for it in principle. Because spaces fill 
quickly with a gray fabric texture strokes.



BIC Pen

Who does not know the famous BIC pens? Well, I simply like the 
idea of having something in my image editing program. So is 
personal XD

It is useful to annotate images or just scribble a little. Self 
increases reaching a black rails is not too much like me drawing 
tablet.

Nice SketchingPen

This tool is a mixture of pencil and ink. You do not have such a 
contour is defined as the ink is not as smooth as a pen. Personal 
preference I saw another artist and he seemed very pleasant to 
view the result. Hence the name. It can be used to make sketches, 
such as pencils.

Normal Brush

The classic of classics. The prehistory of digital art. The beginning 
of any CG artist. A simple circle as a brush tip and the pressure-
sensitive opacity. The advantage is that it is VERY fast. As a 
parametric brush (not defined by a gray-scale displays, but by 
mathematical equations that define parameters) is very versatile. 
May be hard, soft, stiff, spacing, rotated ... but beware of its 
simplicity as there are artists who just brush this paint can truly 
wonders.

Detail Brush

This is the same as the Normal Brush but for details, so do not go into a detailed description. Nor is it 
necessary to see his side through a catch.



Fast Block-Brush

It is a variant of normal Brush but modified slightly so that some 
angular strokes. Sometimes a round tip was not the best option 
and a modified variant can save time.

Knife Palette

The spatula of oil applied to digital art. The images you see in 
many landscapes. And if you're lucky to have a Wacom Intuos can 
make it sensitive to the inclination. But I do not know how to 
react because I have not tried. I use it for large strokes, as masses 
of color but to vary (as in picture) passed deep feeling, buildings, 
rivers and so on. If any of you can check the inclination to send 
me an email and comment how is the experience XDDD.

Block-Brush

I based tool that uses the Church in its Rian DVD. Cool indeed 
and highly recommended. The good thing about this tool is that it 
is digital but it retains the feeling of the tradition. It's a little slow 
in very large sizes and could be better with more options but to 
support fast things go well. If you saw going slow increase 
spacing to 15-20. Loses quality but not in despair.

SmallBlock-Brush

Same as the tool BlockBrush but halved in size. Not go into details either.



Oils-1 Small

Part of my training as an artist is quite traditional. So you will 
find many things like "oil, pencil .." such things as real. 
Simulates the touch of oil with contoured semi-hard but have a 
faint touch on the control of the pressure of the stylus. It is very 
slow if you increase the size, so it should not go.

Oils-1 Big

The alternative double-Large Oils 1.

Soft Oils Small

Oils is an alternative, but more gentle. Ideal for melting colors 
and paint on a classic. Like Oils-1, is slow in very large sizes. It 
can be used for advanced stages of a color image where it is not 
large but specific details or brush areas, medium-small.

Soft Oils Big

The era of purely digital ended long ago, today we like to see 
more images rich in contrasts and textures. To add this effect 
"Mater" is a series of tools that we want simply add powder. Can 
be understood as something when sprinkled Guache Blanco on an 
image to add texture and so on. Can simulate splashing water, 
blood, or simply create a quick way of detail. If we want to do 
more heavy effect that we just have to move to the next tool or 
reduce spacing to "condense" the dust.



Normal Dust

Just another type of dust a little larger to create different effects, 
adding texture to the image.

Rough Dust

Just another type of dust a little larger to create different effects, 
adding texture to the image. The effect here is more coarse 
looking more "serious" or small rocks. It is convenient to use 
with care as quickly fill the whole texture and lose the desired 
goal. Applied correctly, we can generate speckles on the skin very 
interesting very quickly.

Cond Dust

Very condensed powder for very specific purposes. Is between 
the concept of "splash" and "paint". A strange but useful in some 
cases.

Scratches

Based on the concept of David Vyle which I see your excellent 
work. One of the best creators of "Custom Brushes" which I 
know I learned a lot. Allows you to quickly add texture in 
specific areas. It can also be used for painting. Besides, it is quite 
fast. If it moves spacing> 4 the effect is lost.



Rocks & Mountains

David Vyle is again the source of inspiration. Moreover, the 
sample used is that used in your DVD. You can create great 
environments with this tool.

Line Texture

Hmm, actually I did not for this tool but the result I found very 
interesting, so here you are. Creates a striped effect somewhat 
peculiar. Perhaps once we give it a spectacular use.

Leafs1

Another idea based on David Vyle. This time I decided to create 
my own shows for the tip for fun. Very useful if you want to do 
vegetation is highly addictive jaja. Then fill the screen of leaves 
XDD.

Foliage1

This tool is useful for creating vegetation as well but without 
much detail. It creates a lot of texture in the stroke which is great 
for adding detail to rocks, wood, metal ...

If the use of blending modes with color overlay or hard light, you 
can get very interesting textured effects in animal skins, or rocks 
for instance. The default is set to green but I use it as is but works 
with any color.



Scratch Noise

This tool works very well for aging effects, for example, to create 
dirt or to add texture. Is slow because it uses a very large sample 
can provide a timely but very interesting.

Dirty Spot

This exhibition is like a brush that has Sparth (actually use your 
sample but I can not remember where the draw) is great for an 
artistic touch. Quite unpredictable, but very interesting results for 
the structural diversity brings. Should not put large sizes. May 
serve to create masses of clouds or sky.

Clouds

If I have to explain this ... XDD. as its name suggests can be used 
to create all kinds of clouds. Sky clouds, dust, smoke. Uses the 
concept of "particle" of David Vyle but a sample created by me 
(no not think is very different)

Clouds Details

Basically the same as with the clouds but added that this particular entry in "Add." The reason is that it 
comes in handy to fire smoke. Probadlo and understand better:).



CoroBalls

It's very special. Creates feeling of great detail with little effort. 
Useful to trees, or weird stuff. Rather weird stuff but I love and 
that's why I added. This created a sample Elcoro.

Tecno

Another tool for simulation of strange detail in this case 
technology. Interesting sample taken from Deviant Art Do not 
remember who.

If you are the author please contact me. Will be glad to include 
your name.

Circle Chain

The concept of nested chain led to the creative field. It is a bit 
experimental effects and rare but cool?

Glare (FX)

This tool is parametric, which already shows that you can 
generate different types of stars muuuchos without changing the 
Brush. You can change the angle, number of points, spacing etc. 
with only a couple of clicks.



Glow Lights (FX)

Based on the concept of Rian Church to shade and create volume 
with only light. Very useful for all kinds of brightness and light 
effects. For best results use dark colors, but not totally saturated. 
This tool will shed light to the White total.

Glow Dark (FX)

Otherwise Glow Lights (FX). Note that using the same color effect 
is produced in the complementary color.

Light Beam

To create laser effects and stuff so "Cool" we do when we bored. 
Besides that you can create points of light bulbs as a city, the 
lighthouse in the distance a car ... you know.

Mith Disc

Do not be thinking that when I made this XDDD looking for 
something mystical and technological purposes. You say if you is 
helpful. Data for panels, entrances to another dimension?



Airbrush Presets 
These presets are listed by the name found in the Tool Options Restore icon's menu.

Real AirBrush

Nothing much to say except that this tool uses a notion invested 
pressure. The more pressure, the stroke will be smaller. Curioso 
e?

Digital AirBrush

The typical effect of Airbrush. It is not a tool of great mystery, 
but sorely missing, and unless you like airbrushing.

Block AirBrush

Strange experiment. Attempts to cast the concept of BlockBrush with an airbrush.

Glow Airbrush (FX)

Strange experiment. Attempts to cast the concept of GlowLights with an airbrush.



Eraser Presets
These presets are listed by the name found in the Tool Options 
Restore icon's menu.

Soft Eraser

When we need to erase areas of an image smoothly.

Hard Eraser

Areas where we need to delete a picture so hard. This is useful 
when we cut effects.

Round Eraser

A rubber for details. It is neither hard nor soft.

Block Eraser

A very peculiar rubber. Based on the concept of Rian Church. 
"Wipe painting" Useful for creating clear effects.

Tools Ink

These tools rely on speed rather stroke.



Ink Tool Presets
These presets are listed by the name found in the Tool Options Restore icon's menu.

Doodles

This tool is just that, something to scribble quick but much ink. Is 
finding ways that we believe in the spots to start painting 
something and go off while the left hemisphere. As an exercise is 
highly recommended and it's fun. Then you can if you want to 
psychoanalyze.

Fine Sketch 

This tool is more like a pen for scribbling but thinner.

Medium Sketch

This tool is the middle of the two previous

Ink

For various uses. You can create calligraphic effects.



Smudge Presets
These presets are listed by the name found in the Tool Options 
Restore icon's menu.

Normal Smudge

This tool pulls the paint as usual. Is rapid and dependent on the 
spacing. It can be used in areas where the finish is very important 
but the colors mix well.

Soft Smudge

Soft, round tip is ideal for areas where the melt smooth finish is 
important, sensitive jobs such as: skin, gradations, cloth. That sort 
of thing.

Artistic Smudge

The term "Artistic" and think that you should do is something like 
a spatula, which carries a lot of color rather than melt. It's great for 
pictorial effects. The more powerful your stroke is the greatest tool 
in this notice. It can be used for: Funds, Jesus, fabrics with 
wrinkles. The best spacing is usually between 20-40. less digital 
and more would be very weird ... XD.



Jittered Smudge

Special areas where you want to add texture to the molten melt. 
Rocks, backgrounds and stuff.

Balls Smudge

It's amazing how simple it is and how useful is this tool. Going to 
make perfect fade in the clouds and masses of particles. In 
combination with clouds. Hey guy! You'll like it.

Small-Balls-Smudge

The reduced-size version at half Smudge Ball

Wet Smudge

Melts as if're throwing water over. (Get the idea, but you will not 
see dynamic merger or anything like that XD). Create interesting 
effects for use with pencil or ink. Besides using it as a parametric 
brush tip is very versatile. But be careful if you modify some 
parametric brushes in Gimp, it automatically saves the changes in 
the tip of a brush. (if you have the Edit option in the preferences. 
Another day we talk about that).
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Last impressions
I hope you enjoy GPS as I did while I was creating it. It has been several months of hard study and 
comprehensive development, but finally, I have contributed my bit to GIMP. Now I hope it will be 
easier to get started using GIMP and enjoy painting with it.

You can copy, distribute and make new versions of the files and documentation to your liking. Please 
just include my name as originator of the concept and include a link to my blog.

A greeting for the entire global art community. For any questions or suggestions I can be found at:

e-mail: mirandagraphic@gmail.com

Blog: http://ramonmirandavisualart.blogspot.com

Web: http://shock.scenesp.org

Licensing
GIMP is free software; you can redistribute it and / or modify it under the terms of the GNU General 
Public License as published by the Free Software Foundation; either version 2 of the License, or (at 
your option) any later version.

GIMP is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even 
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See 
the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with GIMP; if not, write to 
the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

End of Document 1/02/2009

Ramon Miranda aka TheShock

http://shock.scenesp.org/
http://ramonmirandavisualart.blogspot.com/2009/02/gps-v10.html


Updates
• 2009-03-08:  English version editing of original English language translation from HTML 

source by Michael J. Hammel <mjhammel@graphics-muse.org>

mailto:mjhammel@graphics-muse.org
http://uploader.polorix.net//files/901/GPS%20v1.0.zip
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